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1. Introduction

1.1. Description of the gas analyser

The KIGAZ 110 is a gas analyser with two interchangeable sensors (long-life O, and CO-H,).
Its main features are the following:
»  Sensors protection by pump stopping and configurable thresholds
»  Customers management
»  Creation and edition of inspections with the integrated printer
» 15 programmed combustibles and possibility to add up to 5 combustibles
e 2 GO of memory
The gas analyser is supplied in a transport case with a magnetic protective cover, a flue gas probe and its water trap, a
Li-lon battery and its charger, LIGAZ-2 software which allows inspection creation, an USB cable and a calibration certificate.

This analyser is designed to control parameters of flue gas in exhaust duct or heating units. It can not be used in a
permanently way and/or used as an alarm system.

1.1.1. Overview of the gas analyser

Integrated printer

Screen

Keypad
Handle

Water trap

Fixing cone

Single connector for
flue gas probe
(TcK+gas) and draft

Flue gas probe
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1.1.2. Presentation of the keypad and screen

Measurement screen

Function keys

Esc button

Up arrow

Left arrow

KIGAZ 110

Down arrow

1.1.3. Connections of the analyser

C1 connection for external probe
(Pt100 temperature, CH,,...)

Flue gas probe connection

|‘
P- pressure tap {
P+ pressure tap

T1 thermocouple
connection

Top view Bottom view

On/Off button
Right arrow
OK button

Light for
battery ———
charging

USB
connection

Power
supply

Gas outlet—=—

Right side view
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1.2. Main features

e Screen
LCD screen, 120 x 160 pixels, 50 x 67 mm. It allows to display the measured parameters in a comfortable format for the user. With the
zoom function, the measured values can be visualised in increased characters.

*  Printer
The printer has 10-year guarantee thermal paper. Printer has an easy replacement system of the paper (Easyload). In addition, printing
is fast.

+ Batteries charger
The instrument is supplied with a 6 V, 1.5 A power adapter to load the internal batteries. The current loading is indicated by a battery
symbol on the top left of the screen. The red LED on the right side of the gas analyser stays on until the battery loading is completed.
The battery charging time is 10 hours. The voltage of power supply is 100-240 VAC, 50/60 Hz. The number of cycles of the battery is
about 500 charging cycles.

*  Flue gas suction pump
The pump, inside the gas analyser, is a diaphragm pump with a motor. It is energized in direct current directly by the instrument in a
way to get an optimal suction of flue gases.

e Flue gas probe
Probe in stainless steel with an over-moulded handle in plastic, with a standard length of 18 cm with a fixing cone to maintain the
contact tip in the duct. Interchangeable, it is connected to the instrument by a neoprene tube of 2.50 m.

* Measurement sensors
The analyser uses electrochemical sensors to measure the oxygen and the carbon monoxide (compensated in H, hydrogen).

» Temperature sensors
Flue gas temperature is measured with a thermocouple integrated in the contact tip. The connection to the analyser is made thanks to
a single male connector compensated in temperature. K thermocouple (nickel-nickel chromium) allows continuous measurements up
to 1250 °C.
The instrument has a NTC thermoresistance for the measurement of internal temperature; this sensor is also used for the
measurement of ambient temperature.
If a temperature control of the combustive air must be performed directly by the supply duct (room sealed boiler), a Pt100 temperature
probe (ref: SPA 150 SP) will be used. It is recommended to perform this measurement to make the efficiency calculation of the
installation more accurately.

*  Supply input of flue gases and +/- pressure
The analyser has a single connector which allows to plug the flue gas probe.

* Types of combustibles
The analyser is supplied with a memorization of technical data which characterizes the 15 most known combustibles. It is also possible
to add 5 combustibles and their corresponding features.

« (Calibration certificate
The analyser is calibrated by comparison with standard of metrology laboratories, which are periodically certified closed to laboratories
known at the international level. Each analyser is supplied with its calibration certificate in which, for every parameters, are indicated
the nominal value, the one measured, the admitted error limits and the found error.

*  EMC compatibility
The analyser complies with n°2004/108/EC directive on electromagnetic compatibility. Document available on request.

»  Conformity
The gas analyser is in compliance with the EN 50379-1 and 2 standards.

«  Water trap
The water trap is placed on the tube that links the flue gas probe to the KIGAZ 110. The measured gases go through the filtering
element allowing the recovery of condensates (liquid or solid one).
The filtering element is placed 15 cm from the analyser and is divided into 2 parts:

Introduction 9



- one recovers the liquid particles,
- the other contains a filter that stops the smallest particles in suspension and avoid them to reach the electro-chemical sensors.
gondensates are evacuated by opening the plug.

i ]
For a better measurement, the water trap must he /
in vertical position. Check that both ends are well fe Incase of water presence, do not
clipped to ensure a good J forget to empty it after each use
Empty and clean the mater trap after use. waterproofness £
1§
-«—— Lower plug
N J

A The presence of a water trap with filter can cause some gases solubility in water during gas analysis.

* Auto-zero
The analyser has the “auto-zero in the duct” function, it means that the operator can perform measurements (draft, temperature...)
while the analyser inhales fresh air in the room. This function allows to save time on the inspection .

*  CO protection
The analyser is equipped with the CO protection function that allows to avoid high concentrations of CO that could damage the
analyser and the sensors. The suction-pump is stopped when it exceeds a threshold defined by the user. It is also possible to press the
Kigaz OK key to activate the protection during a gas analysis.

» Customers, boilers and inspections management
The analyser allows to record customers, theirs respective boilers and inspections. Once the features of customers and boilers are
completed in the analyser, the operator can easily assign the different measured values to a customer and his boiler.

*  Opacity index measurement (optional)
It is possible to fill in the analyser with opacity index values measured according to the Bacharach scale. The analyser will calculate the
average and results will be printed on the ticket. This measurement must be performed with an opacity pump which is available as an
accessory (ref: PMO).

*  Gas network leak testing (optional)
It is possible to check the tightness of an installation. For this control, use the pressure sensor used for the differential pressure
measurement of the shaft (ref. KEG).

*  Measured values
- 0,: percentage of oxygen in flue gases
- CO: concentration of CO in flue gases
- Tf: flue gases temperature
- Ta: combustive air temperature

» Calculated values
- A: Air Excess : connection between the volume of combustive air and the requested volume necessary for a combustion in
stoichiometric conditions.
- CO,: percentage of carbon dioxide in flue gases.
- AT: difference between the flue gases temperature and the combustive air temperature.
- Qs: percentage of waste heat throughout the chimney.
- ns: Lower efficiency (or sensible): calculated burner efficiency. This is a ratio between the conventional heating power
and the burner heating power. Among the combustion losses, only the sensible heat lost with the flue gases is taken into
account, neglecting the radiation losses and incomplete combustion losses. This value is referred to LHV (Lower Heating
Value) and can not be higher than 100%.
The sensible efficiency value is to be compared with the minimum efficiency stated for the heating systems performances.
- nt: Higher efficiency (or total): is the sum of sensible efficiency and the additional efficiency deriving from the recovery of
water vapour condensation contained in the flue gases. When it s greater than sensible efficiency, then condensation is
taking place. It is referred to LHV (Lower Heating Value) and can exceed 100%. The LHV is calculated by an algorithm
developed by Kimo and its value must be considered as indicative.

- CO (0): Concentration of CO in flue gases in mg/m®. It is calculated according to O, reference value indicated in the
analyser (see page 19).
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1.3. Technical features

Parameter

Sensor

Measuring range

Resolution

Accuracy*

Too response

time
Long-life O; Electro-chemical |From 0 % to 21 % 0.1 % vol. |£0.2 % vol. 30s
From 0 to 200 ppm: £10 ppm
co From 201 to 2000 ppm:
(with H, Electro-chemical |From 0 to 8000 ppm 1 ppm 5% of measured value 30s
compensation) From 2001 to 8000 ppm:
+10% of measured value
E;epgf:ture K thermocouple  [From -100to +1250 °C  [0.1°C  |+0.4% of measured value or +1.1 °C 45
Ambient intemalNTC  |From 2010 +120°C  01°C  |0.5°C :
temperature
?eTnl::rn;ture E:;gg g%tgrlml From -50 to +250 °C 0.1°C 10.3% of measured value or £0.25 °C 30s
Dew.-point Calculated”™  FromOto+99°Ctd  0.1°C - -
temperature
DHW temperature gfgbgixternal From -200 to +1300 °C |0.1 °C +0.4% of measured value or £1.1 °C -
From -20 000 to -751 Pa:
Differential From -20 000 to 1Pa 10.5 % of measured value +4.5 Pa
pressure +20 000 Pa From -750 to -61 Pa:
10.9 % of measured value 1.5 Pa
Semiconductor From -60 to 60 Pa: £2 Pa -
From 61 to 750 Pa:
Draft From -10 to +10 Pa 0.1Pa +0.9 % of measured value +1.5 Pa
From -1000 to +1000 Pa |1 Pa From 751 to 20 000 Pa:
+0.5 % of measured value + 4.5 Pa
Losses Calculated** From 0 to 100 % 0.1% - -
Excess air (A) Calculated™ From 1t0 9.99 0.01 - -
:'r;’s";’e’ efficiency |caiculated™  |From 010100 % 01% - -
Higher efficiency
(nt) Calculated** From 0 to 120 % 0.1% - -
(condensing)
Opacity index E xternal From0to 9 - - -
instrument

* All accuracies indicated in this document were stated in laboratory conditions and can be guaranteed for measurements carried out in the same conditions, or carried out with required

compensation.

** Calculation is made based on the measured values by the analyser.
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2. Safety

2.1. Precautions for use

Please always use the device in accordance with its intended use and within parameters described in the technical features in order
not to compromise the protection ensured by the device.

2.2. Symbols used

For your safety and in order to avoid any damage of the device, please follow the procedure described in
this user manual and read carefully the notes preceded by the following symbol:

The following symbol will also be used in this user manual:
Please read carefully the information notes indicated after this symbol.

2.3. Safety instructions

The following safety instructions have to be strictly observed.
Not respecting these safety instructions can lead to a loss of warranty.
» The analyser should not to be used in and under water.

* The analyser should not to be placed near or directly at open fire or heat.

» The indicated range of temperature of the probe is not to be exceeded, as the probe and temperature sensor could
be destroyed.

» After measurements, before packing the analyser, wait for the probe to be cold. As long as it is hot, the probe could
cause injuries.

* The exhalations of alcohol liquids (lubricants, petrol, spirit, vanish...) may damage the sensors of the analyser.
Therefore, it is forbidden to preserve or use these fluids nearby the analyser.

* Load the battery only with Kimo charger. The charger must be used only for the power supply loading. Use another
type of charger can damage the battery and the analyser and can cause electrical shocks.
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3. Perform a flue gas analysis

3.1. Prepare the instrument before the analysis

A
A
A
A

A\

VV VYV

KIGAZ 110

Home Measurements Measurements Measurements Sahara/Fos Nat. Gas
o:
% 39 A 123
Customer Auto-zero Temperature Groninguen Nat. Gas ggﬂ 0 9/: o
eting Pressure Russia Nat. Gas 500' 95 z;: 1071
0.95 (b2366) —_— > - » | Maxco Propane S E

Serial num. : 1A 12.34.56789 froeduwes | Opscity PG C 281 % 06
Ambient CO5 Butane i3 402 pom 0

During the measurement, the analyser must be in vertical position or in horizontal position. Do not hold the analyser

in inclined position.

Before the 1° use of the analyser, a full charge of the battery must be made during 12 hours.

Empty the water trap.

In case of any default or damage of the instrument, Kimo After sales service shall be contacted. On the back of the
analyser, there is a label with the analyser serial number. This number shall be communicated for every operation

(technical operation or request of spare parts).

3.2. Perform an analysis

Connect the flue gas probe to the analyser.

Turn on the instrument.

Home screen is displayed with measurement menu highlighted.

Press OK.

The screen with the different possible measurements is displayed.
Remaining time of auto-zero and its progress bar are displayed at the bottom
of the screen.

Go to “Flue gas analysis” with up and down arrows.

Press OK.

The screen displays the different combustibles in the analyser.

Select the type of used combustible by the boiler with with up and down arrows.

Press OK.
The screen displays values of the different parameters of the analysis.

Connecting
flue pipe

4 D

Probe

Save Print Hold

Press the “Hold” function
button to hold the measurement.

Perform a flue gas analysis
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3.3. Zoom function

From the gas analysis screen, the zoom function is available using the direction arrows.
The initial screen displays 10 measured values.

To zoom in, press the right arrow.

The screen displays 5 measured values.

To zoom in again, press the right arrow.

The screen displays 2 measured values.

To zoom in again, press the right arrow.

The screen displays one measured value.

To zoom out, press the left arrow.

At any time, press the down arrow to scroll the values.

Vv V VYV V

CTW s L s W %% os
Sahara,/Fos Nat. Gas Sahara/Fos Nat. Gas Sahara/Fos Nat. Gas Sahara/Fos Nat. Gas
0. 39
% 39 123 % 0: 19
Cco :
fom 0% 9% ppm 0 %
go: 95 | —s |Co a5 | —= — |02 39
0 - g
I 081 % 08 1 ——— %
° .
s 402 3 0 S (ol0)
oC 402 ppm
v v v v
Sovo —Prin o

|

Sahara/Fos Nat. W
co 39
ppm
CO:

0
%

v
Save Print Hold

3.4. Assign the analysis to a customer

» Atthe end of the analysis, when measurements are constant, it is possible to assign it to a customer recorded in the analyser
or to unrecorded customer that should be created.
» Press the “Save” function button.
The analyser displays the list of recorded customers.
» Select a customer with up and down arrows then press OK or create a customer (see page 22) then select it.
The analyser displays the list of available boilers.
» Select the boiler with up and down arrows then press OK or create a boiler (see page 23) then select it.
The analyser backs to the measurement screen of the analysis.

3.5. Add the measurement to a group

The groups allow to regroup measurements in folders. The group function has to be activated (see page 18).
Once the measurement is linked to a customer and a boiler, it is possible to add it in a group in the instrument, or create a group:
The analyser proposes to add the measurement to a group.

» Go to YES and press OK.
» Go to the required group with the arrows and press OK, or create a group (see page 24).
The analyser backs to the measurement screen.

3.6. Print the analysis results

It is possible to print the results on the ticket:
» Press the “Print” function button.
Results are printed on the ticket.
See page 17 for the printing configuration.
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4. Perform a quick measurement

The quick measurement allows to perform in a few seconds:

and an ambient CO measurement with Max CO.

* aflue gas measurement
e adraft measurement

[ ]

>

During the quick measurement, it is possible to print a ticket at each step by pressing the “Print” function button, or print the

whole measurements when the analyser proposes it at the end of the quick measurement (screen 14).

INSTRUMENTS

KIGAZ 110
0.95 (b2366)
Serial num.: 1A 12.34.56789

Home

Customers

Setting

Procedure

Information

— -

Measurement

Auto-zero

—
Screen 1 Screen 2 Screen 3
Max CO Max CO Draft press.
Take out probe Amb. CO measurement
of duct <— | Probe? - Pr.
Pa 3'0
Next Print Purge
Screen 10 n Screen 9* Screen 8 Or "Purge” to perform a
digital auto-zero
Max CO Max CO Max CO
Max CO .- Max CO 0
Auto-zero ppm m ppm
—( Duration: 30 sec —_— co D
ppm
- Press OK Duration: 29 sec
to Start
I
Screen 11 Screen 12 Or "Duration" to set the Screen 13

measurement duration

Next.

Screen 4
Sahara/Fos Nat. gas
% 39 A 123
Fom 0% 9
© g5 o
kS 81 % 06
b 402 n 0
v
Next Print Hold
Screen 7

Max CO

Quick measurement complete

Measurement Measurement
a
Max CO
Temperature Bacharach index
Max CO g | lonisation current
Bacharach index Leak detection
Ambient COp
v

Screen Sl m

Flue gas analysis

Groninguen Nat. gas

Russia/NsN Nat.gas

Propane

LPG

Butane

v

Screen 6

Printing...

Print? Quick measurement
—
Screen 14 Screen 15 l

* If the CO SCOT probe is used, select “External” then follow the instructions on the analyser.

Max CO

Cut the ticket
Print again?

Screen 16

Perform a quick measurement
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5. Set the different parameters of the analyser

The “Setting” menu allows to set the following parameters:
Instrument (screen, printing, auto-off,...)
Combustibles

Measurement

References (O,, atmospheric pressure and altitude)
Auto-zero/Purge

Operators

A The “Setting” part allows to set parameters that can affect the performed measurements. These settings must be
made by a qualified technician.

5.1. Set the instrument

5.1.1. Screen setting

This part allows to set the backlight of the screen from 1 to 9.
» Turn on the instrument.
Home screen is displayed.
Go to “Setting” with keypad then press OK.
Go to “Instrument” then press OK.
The screen with the parameters to set is displayed.
Press OK on the “Screen” line.
Press OK on the “Backlight” line.
Use the up and down arrows to set the parameter then press OK to validate.

5.1.2. Set the auto-off

The auto-off allows to turn off the analyser automatically after some time of non-use.
It is possible to set the auto-off at 15/30 /45 /60 / 90 or 105 minutes or to deactivate it.
“Setting > Instrument” screen is displayed.
»  Go to “Auto-off” with the keypad then press OK.
» Select the required time of auto-off or “Off” to deactivate it with the keypad.
» Press OK.

5.1.3. Change the language

It is possible to select the language of the instrument: French or English in standard. A third language is downloadable through the
LIGAZ-2 software.
“Setting > Instrument” screen is displayed.
» Go to “Language” with the keypad then press OK.
» Select the language with the keypad.
» Press OK.

5.1.4. Modify date and time

“Setting > Instrument” screen is displayed.

Go to “Date/time” with the keypad then press OK.

Go to the parameter to modify with the keypad (day, month, year, hour, minute or second).

Press OK.

Use the up and down arrows to modify the selected parameter.

Press OK.

Repeat the procedure on another parameter if required.

Go to “Date Format” with the keypad then press OK.

Select « Day/Month » to display the day then the month or “Month/Day” to display the month then the day then press OK.
Go to “Time Format” with the keypad then press OK.

Select the time format: “12” or “24”.

If 12 is selected, “AM” for ante meridiem or « PM » for post meridiem will be displayed in front of the time.
Press the “OK” function key to quit the screen and save the modifications or press Esc to cancel.

VVV VYV
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5.1.5. Ticket printing setting
“Setting > Instrument” screen is displayed.

» Go to “Printing” with the keypad then press OK.
» Go to “Format” with the keypad then press OK.
» Select the ticket format: long or short with the keypad then press OK.
Long ticket format: prints the headers, the user name, Short ticket format: prints only the device reference, the type
the type of device and its serial number, the customer and  of combustible, the date and time and the measurement
the selected boiler, the type of combustible, the inspection  results.
date and time and the measurements results.
o 2 RIGAZ 110
[KIMO] Serial num. :
TR 3C 150699999
Entéte 1
Entéte 2 <
Entéte 3 SaharafFos Hat. gas
Operator Operateur 1 Date : 08/12/2015
gnature Time : 15: 21: 07
Measured values
KIGAZ 110 02 3.0 %
Serial num co 0 ppm
3C 150699999 Amb. T 25 31
Gas T Clefiabitele
Combust. :
Sahara/Fos Nat. gas
Date 08s12/2015
Time . 15 21.07 Calculated values
Measured wvalues co2 11.9 %
Diff. T o
0z 3.0 % e - 1R
Egb. T gs?gm c hlghEé;%- ?gfl%%
Gas T 0.1 *C Losses 1.0 %
NOx 0 ppm
Calculated valugs_l
coz 11.9 %
Dirr ¥ S
Low EfFf 99.0 %
High Eff 104.1 %
I..osses 1.0 %
B% soine o om
a0 (02 0 e
02 ref. 21.0 %
» Go to “Logo” then press OK to activate it: ON or deactivate it: OFF.
» Go to the first line of the “Header” then press OK.
The keypad appears at the bottom of the screen.
» Select the letters with the keypad then press OK.
» Press the “OK” function key to validate the line.
The keypad disappears.
» Press Esc to back to “Setting instrument” screen and validate modifications.

To go from lower-case keypad to upper-case keypad then to numeric keyboard: press the “A a 1” function key.
* Toerase a letter: press the “Delete” function key.

5.1.6. Activate or deactivate the visual support

The visual support corresponds to help windows displayed met during a measurement procedure.
“Setting > Instrument” screen is displayed.
» Go to “Support” with the keypad.
» Go to “Visual support” line with the keypad.
» Press OK to activate it: ON or to deactivate it: OFF.

Set the different parameters of the analyser



5.1.7. Activate the group function

Groups allow to gather measurements in a folder. To activate it:
“Setting > Instrument” screen is displayed.
» Go to “Group” with the keypad.
» Press OK to activate it: ON or to deactivate it: OFF.
For the groups creation and management, see page 24.

5.1.8. Select the alarm sound

“Setting > Instrument” screen is displayed.

Go to “Audio” with the keypad then press OK.

Press again OK

Select with the keypad the Alarm 1 sound or the Alarm 2 sound then press OK.

YV V

5.1.9. Activate or deactivate Bluetooth® function (optional)

Bluetooth® allows to set and transfer data from a computer to the analyser or vice versa. It also allows to communicate with the Ligaz
mobile application.
“Setting > Instrument” screen is displayed.
» Go to “Bluetooth” with the keypad.
» Press OK to activate it: the box is ticked, press OK again to deactivate it: the box is unticked.

The * icon appears on the instrument screen when it is activated.

When Bluetooth® is activated, the KIGAZ analyser appears with the name “Kigaz” in the available devices list of the computer,
tablet or smartphone.

5.2. Set the combustible

15 different combustibles are recorded in the analyser:

Sahara / Fos Natural gas Cannel-coal
Groningen — Natural gas Low volatile coal
Russia — Natural gas Coke gas
Propane Biofuel 5%

LPG Wood 20%
Butane Hog fuel 21%
Light oil Pellet 8%

Heavy fuel oil

5.2.1. Modify a combustible
Each combustible has its own coefficient allowing to calculate losses and efficiencies in the most accurate way.

The modification of these coefficients will lead some modifications in combustion analysis results. Only a
qualified technician is authorized to modify them.

It is still possible to reset the factory parameters pressing the “Factory parameters” function key or with the
LIGAZ-2 software (see page 53).

“Setting” screen is displayed.

Go to “Combustibles” with the arrows then press OK.

Go to the required combustible with the up and down arrows then press OK.

Go to the coefficient to modify with the up and down arrows then press OK.

The keyboard is displayed.

Select the numbers with the arrows and press OK to validate.

The analyser backs to the combustibles list.

To go from lower-case keyboard to upper-case keyboard then to numeric keyboard: press the “A a 1” function key.
To erase a letter: press the “Delete” function key.

YV VYVV

It is also possible to modify the name of a combustible and its type of energy (solid, liquid or gas):
“Setting > Combustibles” screen is displayed.
» Go to the combustible to modify with the up and down arrows then press OK.
» Press the “Modify” function button.
» Press OK on the “Name” line.
The keyboard appeatrs.
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Select the letters with the direction arrows and press OK to validate.

Press the “OK” function key to validate the new combustible name.

Press OK on the “Energy” line.

Select the combustible energy type: solid, liquid or gas and press OK.
Press the “Save” function key.

The instrument backs to the combustible list with the modifications applied.

5.2.2. Add a combustible

Up to 5 combustibles can be added in the instrument's memory:

>

VVVVY 'V
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>
>

“Setting > Combustibles” screen is displayed.

Press the “Add” function key.

‘Add combustible” screen is displayed.

Press OK.

The keyboard appears.

Enter the name of the combustible with the keyboard using the arrows and press OK.
Press the “OK” function key to validate the name of the new combustible.

Go to “Energy” line with the keypad and press OK.

Select “Solid”, “Liquid” or “Gas” with the keypad and press OK.

Press the “Save” function key to save the new combustible.

Screen backs to the list of combustible. The new combustible in well on the list in last position.

Every coefficient of the new combustible is set at 0.
Follow the procedure of modification of combustible coefficients described page 18.

5.2.3. Delete a combustible

“Setting > Combustibles” screen is displayed.
Go to the combustible to delete with the keypad.
Press the “Delete” function key.

5.3. Set the alarms, measurement units and CO protection

It is possible to activate an alarm for each measurement parameter. This alarm can be rising (the alarm of the instrument is activated
when the measured value exceeds the defined threshold) or falling ( the alarm of the instrument is activated when the measured value
is below the defined threshold).

It is possible to set an alarm for the following parameters:

0., CO, Amb. CO, CH,, CO;, Qs (losses), A (excess air), nt (lower efficiency), ns (higher efficiency), Tf (flue gas temperature),

Ta (ambient temperature), Td (dew-point temperature), Pr. (pressure), AP (differential pressure).

VV VYVV
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5.3.1. Set the alarms

“Setting” menu is displayed.

Go to “Measurement” with the keypad then press OK.

Press OK on the “Alarms” line.

Go to the parameter to modify with the keypad then press the “Modify” function key.
The edge (rising or falling) and the threshold of the selected parameter are displayed.
Go to the “Edge” line with the keypad then press OK.

Select the type of alarm with the keypad:

+ Rising edge: A 4

» Falling edge: ! A4

«  Deactivated alarm: A %

Press OK.

Go to the “Threshold” line then press OK

The keyboard appears.

Enter the alarm threshold value with the keypad and press OK to validate.

Validate the threshold with the “OK” function key.

Validate the modifications with the “Save” function key.

Press Esc to quit the screen.

5.3.2. Set the measurement units

It is also possible to select the measurement unit for each measured parameter:

Temperature: °C, °F
Draft: Pa, inWg, hPa, mbar, mmHg, mmH-0, psi
Differential presure: Pa, inWg, hPa, mbar, mmHg, mmH.0, psi

Set the different parameters of the analyser
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CO and CO,: ppm, mg/m®, mg/kWh, g/kWh, g/GJ, g/m?, %
“Setting” menu is displayed.

Go to “Measurement” with the keypad then press OK.

Go to “Units” with the keypad then press OK

Go to the parameter to modify with the keypad then press OK.
The list of the available units according to the parameter appears.
Go to the requested unit with the keypad then press OK.

Press Esc to quit the screen.

5.3.3. Set the CO protection threshold

The CO protection allows to protect the instrument against high concentrations of CO. Above the protection threshold, the instrument
will stop the CO dilution by pump stopping but the other measurements are still possible. To set this threshold:

“Setting” menu is displayed.

Go to “Measurement” with the keypad then press OK.

Go to “CO protection” with the keypad then press OK.

Press the “Modify” function key to modify the threshold.

Enter the requested threshold then press the “OK” function key to validate the threshold.

Press Esc to quit the screen.

5.3.4. Set the display

“Setting” menu is displayed.

Go to “Measurement” with the keypad then press OK.

Go to “Display” with the keypad then press OK.

Press the “Viewable” function key to activate or deactivate the measurement display.
Press the “OK” function key to validate.

VV VYVYV
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5.4. Set the references

The “Setting > References” screen allows to set the features of the measurement environment; O, reference, altitude and
atmospheric pressure.
“Setting” screen is displayed.
» Go to “References” with the keypad then press OK.
» Select the parameter to modify with the keypad then press OK.
The keyboard appeatrs.
» Enter the parameter value with the keypad then press OK to validate.

5.5. Set the duration of auto-zero and purge time

The auto-zero allows the analyser to exhaust ambient fresh air and as a result to put the sensors at 0 ppm.
“Setting” screen is displayed.
» Go to “AutoZ/Purge” line with the keypad then press OK.
» Press OK.
The list of available duration appears.
» Go to the required duration then press OK.
» Press Esc to quit the screen.

5.6. Set the operators

It is possible to enter in the analyser names of operators who will use the instrument. The operator who performs an analysis appears
on the ticket (only for the long size format).

5.6.1. Add an operator

“Setting” screen is displayed.

Go to “Operator” with the keypad then press OK.

Press the “Add” function key.

The keyboard appears.

Enter the name with the keypad: press OK to validate.

Press the “OK” function key to validate the operator name and to add it in the list.
The analyser backs to the list of present operators.

Press Esc to quit the screen.

YV VV VY

20 Set the different parameters of the analyser



5.6.2. Modify the operator name

“Setting” screen is displayed.

Go to “Operator” with the keypad then press OK.

Press the “Modify” function key.

The keyboard appears.

Modify the name with the keypad: press OK to validate.
Press the “OK” function key to validate the operator name.
The analyser backs to the list of current operators.

Press Esc to quit the screen.

YV VYV VYV

5.6.3. Delete an operator

“Setting” screen is displayed.

Go to “Operator” with the keypad then press OK.
Go to the operator to delete with the keypad.
Press the “Delete” function key.

Press Esc to quit the screen.

Y VVY

5.7. Back to factory setting of the analyser

It is possible to set the analyser with its factory setting.
“Setting > Instrument” screen is displayed.
» Press the “Factory setting” function key.
A message is displayed and asks to confirm the return to factory seftings.
» To confirm, go to “OK” with the keypad then press OK.
» To cancel, press Esc or go to “Cancel” with the keypad then press OK.

5.7.1. Units and values of measurement settings of the factory setting

Temperature: °C
Draft: Pa
Differential pressure: mbar
CO: ppm
COx: %
Alarm thresholds:

. 02:3.0%

e CO: 100 ppm

*  Amb CO: 10 ppm

* Excessair (A): 1.10

*  Flue gas temperature (Tf): 250.0 °C
Reference:

e 0:210%

* Altitude: 800 m

»  Atmospheric pressure: 1013.25 hPa
CO protection threshold: 2000 ppm
Duration of auto-zero and purge: 1 minute

Created operators and combustibles will be deleted. Created customers, boilers and inspections on boilers are not
deleted after a return to factory setting.

5.7.2. Device factory setting

Back-light: 7

Auto-off: 15 minutes

Language: French

Print: long ticket, logo display deactivated and empty headers
Visual help: ON (activated)

Alarm audio parameter: Alarm 1

Groups: OFF (deactivated)

Bluetooth (option): deactivated
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6. Manage customers

It is possible to save names and addresses of different customers in the analyser. The performed measurements could be assigned to
them. It is possible to create up to 250 customers.

6.1. Manage a customer

Turn on the analyser.

Go to “Customers” with the keypad then OK.

Press the “Add” function key.

“Add customer” screen is displayed.

Press OK on “Name” line.

The keyboard appears.

Enter the customer name with the keyboard and press OK to validate the letters.

Press the “OK” function key.

The analyser backs to “Add customer” screen.

Go to the 1* line of the address with the keypad then press OK.

Enter the 1% line of the customer's address with the keypad and press OK to validate letters.
Press the “OK” function key.

The analyser backs to “Add customer” screen.

Go to the 2" line of the address with the keypad then press OK.

Enter the 2" line of the customer's address with the keypad and press OK to validate letters.
Press the “OK” function key.

The analyser backs to “Add customer” screen.

Continue for both following lines of the address if necessary.

Go to “Tel” line with the keypad then press OK.

Enter customer's telephone number with the keyboard and press OK to validate the letters.
Press the “Save” function key.

The analyser backs to “Customer List” screen with the created new customer.

VVVY VVV VVV VYV V VVYVY

When a customer has been created, it is possible to link to this customer one or several boilers. See page 23 to create, modify and
delete a boiler.

6.2. Modify a customer

“Customers” screen is displayed.

Go to the customer to modify with the keypad then press OK.
Press the “Detail” function key.

Details of the customer are displayed.

Press the “Modify” function key.

Go to the line to modify with the keypad then press OK.

The keyboard appears.

Make the changes.

Press the “Save” function key to validate.

The analyser backs to “Customer detail” screen.

Press the “Save” function key once all the changes have been made.

YV VV VV VYV

6.3. Delete a customer

“Customer” screen is displayed.

Go to the customer to delete with the keypad then press OK.
Press the “Delete” function key.

A message appears asking to confirm the deletion of the customer.
Go to YES then press OK to confirm the deletion.

Go to NO then press OK to cancel.

VV VYV
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7. Manage boilers

Aboiler is compulsorily linked to a customer, at least one customer must be created to create a boiler. See page 22 for the creation of a
customer. It is possible to link up to 10 boilers per customer.

7.1. Create a boiler

VVVVYVY VYV VVYVYVY

The list of customers saved in the analyser is displayed.

Go to the customer which will be linked to the boiler with the keypad then press OK.

Press the “Add” function key.

Press OK on “Model” line.

The keyboard appears.

Enter the model of the boiler with the keypad then press OK to validate the letters.

Press the “OK” function key to validate the model.

The analyser backs to “Add boilers” screen.

Do the same for “Brand”, “Address”, “Location” and “Air pulsed burner”.

Press OK on “Tightness” line, select “B Type” (untight) or “C Type” (tight) then press OK.
Press OK on “Combust.” line, select the type of combustible for the boiler then press OK.
Press OK to tick the “Air pulser burner” box if the boiler has one.

Press the “Save” function key to save the boiler features.

The analyser backs to the list of boilers.

7.2. Modify a boiler

YV VV VV VYV

The list of boilers saved in the analyser is displayed.

Go to the boiler to modify with the keypad then press OK.
Press the “Detail” function key.

Details of the boiler are displayed.

Press the “Modify” function key.

Go to the line to modify with the keypad then press OK.
The keyboard appeatrs.

Make the modifications.

Press the “Save” function key to validate.

The analyser backs to “Modify boiler” screen.

Press the “Save” function key once all the changes have been made.

7.3. Delete a boiler

VYV VYV

The list of boilers saved in the analyser is displayed.

Go to the boiler to delete with the keypad then press OK.
Press the “Delete” function key.

A message appears asking to confirm the deletion of the boiler.
Go to YES then press OK to confirm the deletion.

Go to NO then press OK to cancel.
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8. Manage the inspections

Each saved inspection is linked to a customer. It is possible to see the details of an inspection, to add one or to delete one.

Available inspections in the analyser are the following: combustion, ambient temperature, flue gas temperature, internal temperature,
Flow/Return temperature, dew-point temperature, draft pressure, differential pressure, flue gas velocity, Max CO, opacity, ambient CO»,
ionisation current, leak detection, gas network tightness and gas flow.

The maximum number of inspections is 10 per boilers.

8.1. Get to inspections

To find every inspections of a customer and details of this inspection, follow the specified procedure:

The list of customers saved in the analyser is displayed.

» Go to the required customer then press OK.
Every boilers linked to this customer are displayed.

» Go to the required boiler then press OK.
Every inspections linked to this customer and boiler are displayed.

» Go to the required inspection then press OK.
Details of the inspection are displayed.

8.2. Create an inspection

It is possible to create an inspection for specific customer that will be performed later.
The list of customer's inspections is displayed.
» Press the “Add” function key to add an inspection.
Alist of inspections is displayed.
» Go to the required inspection then press OK.
The inspection is added with “Not done” mention.

8.3. Delete an inspection

To delete an inspection of a customer.
The list of customer's inspections is displayed.
> Press the “Delete” function key to delete an inspection.
» Go to YES then press OK to delete the inspection or go to NO then press OK to cancel.

8.4. Create a group

Groups allow to gather measurements in a folder. This function has to be activated (see page 18). To create a group:
» Once the measurement is finished, press the “Save” function key to save it.

The analyser displays the recorded customers list.

Select a customer with the keypad and press OK or create customer (see page 22) and select it.

The analyser displays the available boilers list.

Select a boiler with the keypad and press OK or create a boiler (see page 23) and select it.

The analyser confirms the recording is done.

Press OK.

The analyser proposes to add the measurement to a group.

Choose YES to create a group: press the “Add” function key.

Press OK to name the group.

The keyboard appeatrs.

Use the direction arrows to select letters and press OK to validate them.

Press the “OK” function key to validate the name.

Press the “Save” function key to save the group.

Press OK to save the measurement in this group.

The instrument backs to the measurement screen.
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The created group appears in the inspections list:
» Go to the “Customer” menu with the keypad and press OK.
The analyser displays the list of recorded customers on the instrument.
» Go to the required customer with the arrows and press OK.
The analyser displays all the boilers linked to this customer.
» Go to the required boiler with the arrows and press OK.
The analyser displays all the inspections linked to this customer and boiler and the created groups.
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» Go to the required group folder and press OK.

The analyser displays the inspection list recorded in this group.
» Go to the required inspection and press OK.

The analyser displays the inspections details.

8.5. Add an inspection to a group

The group function has to be activated (see page 18). If an inspection or a measurement is not added to a group during the recording,
it is possible to add it later:

Go to the required inspection or measurement with the arrows.

Press OK to display the details.

Press the “Add” function key to add it to a group.

Select the group to add the measurement or inspection with the arrows, or create a new group (see page 24).

Press OK to validate.

The measurement is saved in the group.
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8.6. Delete a group

To delete a group:
» Go to the “Customer” menu with the keypad and press OK.
The analyser displays the list of recorded customers on the instrument.
Go to the required customer with the arrows and press OK.
The analyser displays all the boilers linked to this customer.
Go to the required boiler with the arrows and press OK.
The analyser displays all the inspections linked to this customer and boiler and the created groups.
Go to the required group folder and press the “Delete” function key.
A confirmation message is displayed.
To confirm the deletion: go to YES and press OK. To cancel: go to NO and press OK, or press Esc key.

vV V V V

9. Perform measurement of a customised procedure

Customised procedures, created by the LOGAZ-2 software (optional software), when they are transferred in the analyser can be
performed.

9.1. Preliminary operations to procedures

Before performing the measurements, names of the different customers and theirs respective boilers must be saved in the
A analyser. See page 22 to create customers and page 23 to create boilers or the LOGAZ-2 software user manual (optional
software).

9.2. Launch a customised procedure

Turn on the analyser.

Go to “Procedures” with the keypad then press OK.

Select the customer then the boiler in which measurements will be performed.
Go to “Customised” with the keypad then press OK.

The list of procedures saved in the analyser is displayed.

Select the procedure with the keypad then press OK.

The analyser displays the 1* step of the customised procedure.

Go to “Start” with the keypad then press OK.

The analyser performs the measurement.

Press OK on “Next” if the customised procedure has several step.
The analyser launches the next step.

OR

» Press OK on “Quit” if the customised procedure has only one step.

YV V ¥V VVVYV

The analyser backs to the list of customised procedures. At the end of the procedure, the analyser saves it and automatically links it to
the customer and boiler selected before launching the measurement. It is possible to get to details of this procedure in the “Customer”
menu.

Perform measurement of a customised procedure 25



10. Perform a control of gas flow

10.1. Perform a measurement of theoretical flow

>
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Turn on the analyser. Go to “Procedures” menu with the keypad then press OK.

The analyser asks to select a customer: go to “OK” then press OK.

The list of customers is displayed.

Select the customer then press OK.

The list of boilers is displayed.

Select the boiler then press OK.

“Procedure” screen is displayed.

Go to “Gas flow” with keypad then press OK.

A message indicating “Step 1: Theoretical flow” is displayed.

Go to “Next” then press OK.

“Theoretical flow” is displayed.

Specify the power capacity of the boiler in kW (data on the information plate of the boiler): go to each number, press OK,
press the up and down arrows to increment or decrement the number then press OK to validate.
Make the same operation to select the standard: NF or CE.

Make the same operation to select the gas type: GAS H, GAS B, BUTANE or PROPANE.

Press the “OK” function key to validate.

A message indicating “Step 2: Real flow” is displayed.

The theoretical flow is calculated according to a power capacity in kW of the boiler, the standard of the boiler (CE or NF standard), the
gas type (Gas H, Gas B, butane or propane) and according to a coefficient. Table below allows to calculate this flow according to the

power capacity:

Standard

GAS H (19-21 mbar)

GAS B (25 mbar)

Butane

Propane

NF

Pu/KW x 2.166

Pu/KW x 2.519

Pu/KW x 0.651

Pu/KW x 0.843

CE

Pu/KW x 1.927

Pu/KW x 2.241

Pu/KW x 0.579

Pu/KW x 0.750

10.2. Perform a measurement of real flow

Y
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) ) Read a gas meter :
The measurement of the theoretical flow must be performed previously

A message indicating “Step 2: Real flow” is displayed.
Go to “Next” then press OK.

“Start index (L)” is displayed. 1 E O
Specify the start flow indicated on the gas meter: go to each number, press OK,

press the up and down arrows to increment or decrement the number then

press OK to validate. ‘

Press the “OK” function key to validate.

A message indicating “Step 2: Wait: 2 min.” and a progress bar are displayed.
Wait for 2 minutes. It is possible to cancel this measurement: press OK.

Go to “Next” then press OK at the end of the 2 minutes.

“End index (L)” screen is displayed.

Specify the end flow indicated on the gas meter: go to each number, press OK, press the up and down arrows to increment
or decrement the number then press OK to validate.

Press the “OK” function key to validate.

A message displays the flow measurement result.

Totaliser in m® Totaliser in litres

When the measurement is finished:

>

>

Press OK.
The analyser asks to save the measurement result then to print the measurement result.
Go to YES or NO then press OK.

10.3. Results interpretation
The analyser displays the flow result by the following:

OK: lower or equal to 10%
A1: between 10.1 and 20%
A2: greater than 20%
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11. Perform a gas network leak test

To perform this test, it is necessary to have a gas network leak testing kit. This kit is available as option (ref: KEG).

11.1. Perform the test

Connect the different items of the kit on the network to test (see user manual of the KEG).
Turn on the analyser.

Go to “Procedures” menu with the up and down arrows then press OK.

The analyser asks to select a customer and a boiler: go to “OK” then press OK.
The list of customers is displayed.

Select the customer then press OK.

The list of boilers is displayed.

Select the boiler then press OK.

“Procedures” screen is displayed.

Go to “Network tightness” with the keypad then press OK.

A message indicating “Plug silicone tube on P+” is displayed.

Plug the silicone tube on P+ pressure tap then press OK.

A message indicating “Pressurise to 50 mbar” is displayed.

Pressurise the network to 50 mbar then press OK.

A message indicating “Please wait 10 minutes” and a progress bar are displayed.
At the end of the 10 minutes, results are displayed:

e start pressure

e end pressure

»  possible loss of pressure

11.2. Link the measurement to a customer

When the measurement has been performed, it is possible to link it to a customer registered in the analyser or to a customer
unregistered in the analyser that must be created.

>

>

>

Press the “Save” function button.

The analyser displays the list of recorded customers.

Select a customer with up and down arrows then press OK or create a customer (see page 22) then select it.
The analyser displays the list of available boilers.

Select the boiler with up and down arrows then press OK or create a boiler (see page 23) then select it.

The analyser backs to the measurement screen.

11.3. Print the results

It is possible to print the results on the ticket:

>

Press the “Print” function button.
Results are printed on the ticket.

See page 17 for the printing configuration.
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12. Perform a pressure measurement

The draft measurement allows to check if the flue of the boiler correctly clears flue gas caused by the combustion.

12.1. Perform the measurement

Connect the flue gas probe on the analyser.

Turn on the analyser.

Go to the “Measurement” menu with the keypad then press OK.

The analyser performs the gas autozero: remaining time and a progress bar are displayed on the screen.
Go to “Pressure” with the keypad then press OK.

Go to “Draft pressure” with the keypad then press OK.

Measurement launches and the analyser displays the draft.

Measurement

VV VVV

Measurement
process of the draft
in nozzle output

process of the
draft in nozzle '
output gl?g:ie;etmg
s
| —
E———
E———
0
[ S—
E——
E———
O
Put the probe of the KIGAZ 110 in the Put the probe of the KIGAZ 110 in the Put the probe of the KIGAZ 110 in the
draft hood, going through the front face nozzle output, from the beginning of the draft hood, going through the side
of the boiler connecting flue openings of the boiler

12.2. Perform a differential pressure measurement

» Connect the flue gas probe on the analyser.

» Turn on the analyser

» Go to the “Measurement” menu with the keypad then press OK.
The analyser performs the gas auto-zero: remaining time and a progress bar are displayed on the screen. The pressure
measurement remains possible.

» Go to “Pressure” with the keypad then press OK.

» Go to “Diff. Press.” with the keypad then press OK.

» Press “Auto-zero”.
Measurement launches and the analyser displays the differential pressure.

12.3. Perform a flue gas velocity measurement

Connect the flue gas probe on the analyser.

Turn on the analyser.

Go to the “Measurement” menu with the keypad then press OK.

The analyser performs the autozero: remaining time and a progress bar are displayed on the screen.
Go to “Pressure” with the keypad then press OK.

Go to “Flue gas velocity” with the keypad then press OK.

The measurement launches and the analyser displays the differential pressure.

VV VYVV

12.4. Link the measurement to a customer

When the measurement has been performed, it is possible to link it to a customer registered in the analyser or to a customer
unregistered in the analyser that must be created.
» Press the “Save” function button.
The analyser displays the list of recorded customers.
» Select a customer with up and down arrows then press OK or create a customer (see page 22) then select it.
The analyser displays the list of available boilers.
» Select the boiler with up and down arrows then press OK or create a boiler (see page 23) then select it.
The analyser backs to the measurement screen.
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12.5. Add the measurement to a group

The group function has to be activated (see page 18).
Once the measurement is linked to a customer and a boiler, it is possible to add it in a group in the instrument, or create a group:
The analyser proposes to add the measurement to a group.
» Go to YES and press OK.
» Go to the required group with the arrows and press OK, or create a group (see page 24).
The analyser backs to the measurement screen.

12.6. Print the results

It is possible to print the results on the ticket:
» Press the “Print” function button.
Results are printed on the ticket.
See page 17 for the printing configuration.

13. Perform a measurement of ambient CO>

13.1. Perform the measurement

» Connect a CO; probe (available as option) on C1 connection on the top of the analyser.
» Turn on the analyser.
» Go to the “Measurement” menu with the keypad then press OK.
The analyser performs the auto-zero: remaining time and a progress bar are displayed on the screen.
» Go to “Ambient CO.” with the keypad then press OK.
Measurement launches and the analyser displays the level of ambient CO..

13.2. Link the measurement to a customer

When the measurement has been performed, it is possible to link it to a customer registered in the analyser or to a customer
unregistered in the analyser that must be created.
» Press the “Save” function button.
The analyser displays the list of recorded customers.
» Select a customer with up and down arrows then press OK or create a customer (see page 22) then select it.
The analyser displays the list of available boilers.
> Select the boiler with up and down arrows then press OK or create a boiler (see page 23) then select it.
The analyser backs to the measurement screen.

13.3. Add the measurement to a group

The group function has to be activated (see page 18).
Once the measurement is linked to a customer and a boiler, it is possible to add it in a group in the instrument, or create a group:
The analyser proposes to add the measurement to a group.
» Goto YES and press OK.
» Go to the required group with the arrows and press OK, or create a group (see page 24).
The analyser backs to the measurement screen.

13.4. Print the results

It is possible to print the results on the ticket:
» Press the “Print” function button.
Results are printed on the ticket.
See page 17 for the printing configuration.
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14. Perform a measurement of Max CO

14.1. Perform the measurement

» Connect a CO probe (available as option) on C1 connection on the top of the analyser or connect the flue gas probe on the
single connector on the bottom of the analyser.

» Turn on the analyser.

» Go to the “Measurement” menu with the keypad then press OK.
The analyser performs the auto-zero: remaining time and a progress bar are
displayed on the screen.

» Go to “Max CO” with the keypad then press OK.

» Press OK to launch the measurement.
The measurement is launched, the instrument displays the level of CO and the level
of Max CO.
When the measurement duration is finished, the analyser displays the value of
maximum CO during the measurement.

The default measurement duration is 30 s. It is possible to change this duration before
starting the measurement:

» 0On Max CO screen, before pressing OK to start the measurement, press the
“Duration” function key.
“Duration” screen is displayed.
Press OK.
Use the keypad to select the required measurement duration: 30 /40 /50sor1/2/3/4 /5 minutes.
Press OK to validate the measurement duration.
Press Esc to back to the screen of measurement start of Max CO.
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14.2. Link the measurement to a customer

When the measurement has been performed, it is possible to link it to a customer registered in the analyser or to a customer
unregistered in the analyser that must be created.
» Press the “Save” function button.
The analyser displays the list of recorded customers.
» Select a customer with up and down arrows then press OK or create a customer (see page 22) then select it.
The analyser displays the list of available boilers.
» Select the boiler with up and down arrows then press OK or create a boiler (see page 23) then select it.
The analyser backs to the measurement screen.

14.3. Add the measurement to a group

The group function has to be activated (see page 18).
Once the measurement is linked to a customer and a boiler, it is possible to add it in a group in the instrument, or create a group:
The analyser proposes to add the measurement to a group.
» Go to YES and press OK.
» Go to the required group with the arrows and press OK, or create a group (see page 24).
The analyser backs to the measurement screen.

14.4. Print the results

It is possible to print the results on the ticket:
» Press the “Print” function button.
Results are printed on the ticket.
See page 17 for the printing configuration.
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15. Perform some temperature measurements

15.1. Perform a measurement of ambient temperature

» Connect a Pt100 temperature probe (available as option) on C1 connection on the top of the analyser.

» Turn on the instrument.Home screen is displayed with measurement menu highlighted.

» Press OK.
The analyser performs the auto-zero: remaining time and a progress bar are displayed on the screen. However it is possible
to reach the temperature menu during the auto-zero.

» Go to “Ambient Temp.” with the keypad then press OK.
The temperature detected by the Pt100 probe is displayed on the analyser.

15.2. Perform a measurement of flue gas temperature

» Connect the flue gas probe on the analyser.

» Turn on the analyser. Home screen is displayed with measurement menu highlighted.

» Press OK.
The analyser performs the gas auto-zero: remaining time and a progress bar are displayed on the screen. However it is
possible to reach the temperature menu during the auto-zero.

» Go to “Flue gas Temp.” with the keypad then press OK.
The screen displays the flue gas temperature detected by the thermocouple probe of the flue gas probe.

15.3. Perform an ambient temperature measurement with the internal sensor

» Turn on the instrument. Home screen is displayed with measurement menu highlighted.

» Press OK.
The analyser performs the auto-zero: remaining time and a progress bar are displayed on the screen. However it is possible
fo reach the temperature menu during the auto-zero.

» Go to “Internal Temp.” with the keypad then press OK.
The screen displays the NTC temperature detected by the analyser.

15.4. Perform a Flow/Return temperature measurement

» Connect 2 thermocouple probe type Velcro (ref. : SKV 150) or contact with lamella (ref. : SKCT) on the Kigaz.

» Turn on the instrument. Home screen is displayed with measurement menu highlighted.

» Press OK.
The analyser performs the auto-zero: remaining time and a progress bar are displayed on the screen. However it is possible
to reach the temperature menu during the auto-zero.

» Go to “Flow/Return Temp.” with the keypad then press OK.
The screen displays the T1 temperature and the T2 temperature and the delta of temperature (AT) detected by the analyser.

15.5. Link the measurement to a customer

When the measurement has been performed, it is possible to link it to a customer registered in the analyser or to a customer
unregistered in the analyser that must be created.
» Press the “Save” function button. The analyser displays the list of recorded customers.
» Select a customer with up and down arrows then press OK or create a customer (see page 22) then select it.
The analyser displays the list of available boilers.
» Select the boiler with up and down arrows then press OK or create a boiler (see page 23) then select it.
The analyser backs to the measurement screen.

15.6. Add the measurement to a group

The group function has to be activated (see page 18).
Once the measurement is linked to a customer and a boiler, it is possible to add it in a group in the instrument, or create a group:
The analyser proposes to add the measurement to a group.
» Goto YES and press OK.
» Go to the required group with the arrows and press OK, or create a group (see page 24).
The analyser backs to the measurement screen.
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15.7. Print the results

It is possible to print the results on the ticket:
» Press the “Print” function button. Results are printed on the ticket. See page 17 for the printing configuration.

32 Perform some temperature measurements



16. Perform a measurement of opacity

It is possible to enter in the analyser from 1 to 3 opacity indexes performed thanks to opacity pump available as option.
The opacity index consists of the measurement of solid waste of combustion in the flue with a pump and a filter of measurement. The
filter coloration is compared with a table reference composed by 10 greyed areas numbered from 0 to 9.

16.1. Perform the measurement

Preliminary operation:
A To avoid the condensation in the pump, it is necessary to breathe in WITHOUT FILTER fresh air before performing a
measurement.

Put the paper filter in the pump.

Pump out flue gas in the middle of the flue.

The necessary gas volume for a measurement of opacity corresponds to about 10 pump aspirations.
Compare the filter clogging to the reference table to determine the opacity index.

Make the same operation several times if necessary, replace the filter each time.

VV VYV

16.2. Enter the indexes in the analyser

When the measurement of opacity has been performed, enter the opacity indexes in the analyser:

» Turn on the analyser.

The analyser performs the auto-zero: remaining time and a progress bar are displayed on the screen. However it is possible

fo
reach the Bacharach index menu during the auto-zero.
Press OK.
Go to “Bacharach index” with the keypad.
Press OK.
Press OK on “Index 1” line.
Increment the index from 0 to 9 with the keypad.
Press OK.
Repeat the procedure for 2 and 3 indexes.
The analyser indicates the opacity indexes average on “Average” line at the bottom of the screen.
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16.3. Link the measurement to a customer

When the measurement has been performed, it is possible to link it to a customer registered in the analyser or to a customer
unregistered in the analyser that must be created.
» Press the “Save” function button.
The analyser displays the list of recorded customers.
» Select a customer with up and down arrows then press OK or create a customer (see page 22) then select it.
The analyser displays the list of available boilers.
» Select the boiler with up and down arrows then press OK or create a boiler (see page 23) then select it.
The analyser backs to the measurement screen.

16.4. Add the measurement to a group

The group function has to be activated (see page 18).
Once the measurement is linked to a customer and a boiler, it is possible to add it in a group in the instrument, or create a group:
The analyser proposes to add the measurement to a group.
» Goto YES and press OK.
» Go to the required group with the arrows and press OK, or create a group (see page 24).
The analyser backs to the measurement screen.

16.5. Print the results

It is possible to print the results on the ticket:
» Press the “Print” function button.
Results are printed on the ticket.
See page 17 for the printing configuration.
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17. Perform a measurement of ionisation current

The measurement of ionisation current allows to check the presence of the flame. In standard operation, the ionisation probe produces
a currant of a few A or a few dozen of pA. In case of lack of flame, this current is not present anymore (measurement: 0 pA), the
safety equipments of the boiler cut off the power supply.

17.1. Perform the measurement

» Connect an ionisation current probe on C1 connection of the analyser.
» Turn on the analyser.
Home screen is displayed with measurement menu highlighted.
» Press OK.
The analyser performs the autozero: remaining time and a progress bar are displayed on the screen. However it is possible to
reach the ionisation current menu during the autozero.
» Go to “lonisation current” with the keypad then press OK.
» Connect the ends of the probe on the boiler.
The measured ionisation current is displayed on the analyser. This value must be equal to several dozen of UA.

17.2. Link the measurement to a customer

When the measurement has been performed, it is possible to link it to a customer registered in the analyser or to a customer
unregistered in the analyser that must be created.
» Press the “Save” function button.
The analyser displays the list of recorded customers.
» Select a customer with up and down arrows then press OK or create a customer (see page 22) then select it.
The analyser displays the list of available boilers.
» Select the boiler with up and down arrows then press OK or create a boiler (see page 23) then select it.
The analyser backs to the measurement screen.

17.3. Add the measurement to a group

The group function has to be activated (see page 18).
Once the measurement is linked to a customer and a boiler, it is possible to add it in a group in the instrument, or create a group:
The analyser proposes to add the measurement to a group.
» Goto YES and press OK.
» Go to the required group with the arrows and press OK, or create a group (see page 24).
The analyser backs to the measurement screen.

17.4. Print the results

It is possible to print the results on the ticket:
» Press the “Print” function button.
Results are printed on the ticket.
See page 17 for the printing configuration.
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18. Perform a CH; measurement

18.1. Perform the measurement with the probe

>
>
>

Connect a CH, probe on C1 connection on the bottom of the analyser.

Turn on the analyser.

Go to the “Measurement” menu with the keypad then press OK.

The analyser performs the autozero: remaining time and a progress bar are displayed on the screen. However it is possible to
reach the gas leak detection menu during the autozero.

Go to “Gas leak detection” with the keypad then press OK.

Press OK to launch the measurement.

If the probe is connected for more than 1 minute, the measurement screen appears and indicates the concentration and
places it on a bargraph.

If the probe has just been connected, the screen indicates the remaining time of warming.

The measurement begins, the analyser displays the CH, level.

18.2. Link the measurement to a customer

When the measurement has been performed, it is possible to link it to a customer registered in the analyser or to a customer
unregistered in the analyser that must be created.

>

>

>

Press the “Save” function button.

The analyser displays the list of recorded customers.

Select a customer with up and down arrows then press OK or create a customer (see page 22) then select it.
The analyser displays the list of available boilers.

Select the boiler with up and down arrows then press OK or create a boiler (see page 23) then select it.

The analyser backs to the measurement screen.

18.3. Add the measurement to a group

The group function has to be activated (see page 18).
Once the measurement is linked to a customer and a boiler, it is possible to add it in a group in the instrument, or create a group:

>
>

The analyser proposes to add the measurement to a group.

Go to YES and press OK.

Go to the required group with the arrows and press OK, or create a group (see page 24).
The analyser backs to the measurement screen.

18.4. Print the results

It is possible to print the results on the ticket:

>

Press the “Print” function button.
Results are printed on the ticket.

See page 17 for the printing configuration.
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19. Perform a flue gas velocity measurement with a Pitot

tube
A The used Pitot tube must be a Pitot tube type L with K thermocouple connection.

The Pitot tube must be introduced perpendicularly, in the middle into the duct and
parallel to the flow.

The head (ending with an ellipsoidal nose) must be maintained parallel and facing the
flow.

The total pressure (+) catched by the nose, is connected to the P+ at the bottom of the
analyser.

The static pressure (-) catched by the holes of the head, is connected to the P- at the
bottom of the analyser.

The connection cable of the thermocouple K probe is connected to the T1 K
thermocouple inlet of the top of the analyser.

=> Total pressure (Tp)
* Static pressure (Sp)

Dynamic pressure = To-Sp A If no K thermocouple cable is connected, no value is displayed.

When the connections are made:
» Turn on the analyser.
» Go to “Measurement” menu then press OK.
» Go to “Pressure” menu then press OK.
» (o to “Draft Press.” then press OK.
The analyser displays the measured values.

19.1. Link the measurement to a customer

When the measurement has been performed, it is possible to link it to a customer registered in the analyser or to a customer
unregistered in the analyser that must be created.
» Press the “Save” function button.
The analyser displays the list of recorded customers.
» Select a customer with up and down arrows then press OK or create a customer (see page 22) then select it.
The analyser displays the list of available boilers.
» Select the boiler with up and down arrows then press OK or create a boiler (see page 23) then select it.
The analyser backs to the measurement screen.

19.2. Add the measurement to a group

The group function has to be activated (see page 18).
Once the measurement is linked to a customer and a boiler, it is possible to add it in a group in the instrument, or create a group:
The analyser proposes to add the measurement to a group.
» Goto YES and press OK.
» Go to the required group with the arrows and press OK, or create a group (see page 24).
The analyser backs to the measurement screen.

19.3. Print the results

It is possible to print the results on the ticket:
»  Press the “Print” function button.
Results are printed on the ticket. See page 17 for the printing configuration.
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20. To get to information about the analyser

The “Information” menu of the analyser allows to get to several information:
*  Type of analyser
»  Version of the firmware
»  Serial number of the analyser
* The adjustment date
¢ Phone and fax numbers, e-mail of Kimo Instruments
*  Options of the analyser
»  Type of sensor, its serial number and its installation date.

To get to this menu:
From the home screen:
» Go to “Information” menu with the keypad then press OK.
The information is displayed on the screen.
» Use the keypad to go from one screen to the other.

From any information screen:
» Press the “Diagnostic” function key.
The analyser displays information about sensors.

Home Information Information Information Diagnostic
INSTRUMENTS Messuraments KIGAZ 110 KIGAZ 110 KIGAZ 110 Pos 1102 oK
N — = 4 Serial num. : 15.09.0001
KIGAZ 110 _Oustomers Version 0.95 - 2400 Phone : 05.53.80.85.00 Options : - Bluetooth Installed on : 10/08,/2015
Diagnotsic .
Setting . . ) g Pos 2: CO oK
0.95 (b2365) . Serial num. : 2A. 15.06.99999 Fax 0553801631 | [P LOGAZ software | St < 15.07.0001
Procedures Adjusted on:  15/10,/2015 Email kimo@kimo.fr Installed on : 12/07/2015
Serial num.: 1A 12.34.56789
Information
— e
v v
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241. Maintenance of the analyser

21.1. Life-time of the sensors

Sensors are electrochemical type: inside them, in the presence of gas to detect, a chemical reaction occurs that causes an emission of
electrical current. The electric current strength detected by the instrument is converted into a corresponding gas concentration. The
life-time of the sensor is strongly linked to the reagent consumption present in the sensor. As their consumption increases, features of
the sensor are getting worse until their exhaustion, after which it is necessary to replace it. To ensure the measurement accuracy,
sensors have to be calibrated only in Assistance centre qualified by Kimo.

Sensor Average life-time Required calibration

Long-life O, 5 years Annual
CO-H, 2 to 3 years Annual

21.2. Replace the sensors

Follow this procedure to replace a used sensor:

The analyser must be turned off.

Remove the protective cover.

Turn the analyser.

Unscrew the sensors cover with a cross-head screwdriver.

Remove the trap.

Disconnect the ribbon cable of the sensor to replace.

Rotate the sensor counter clockwise taking care not to bring pressure on the board of the sensor.
Remove the sensor.

Put the new sensor taking care to insert the two jacket hooks of the sensor in their location.

Exercise the rotation constraint on the sensor body and not on the electronic card.

|>VVVVVVVV

hooks

> Rotate the sensor clockwise.
> Reconnect the ribbon cable of the sensor.

Disconnection of the
ribbon cable of the sensor
to replace

Sensor rotation Remove the used
sensor

Sensors access
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0 , sensor location

CO sensor
location

Insertion of a new sensor then rotation Connection of the
of the sensor sensor ribbon cable

Exercise the pressure on the sensor body and not on the electronic card.

* Long-life O sensor must be in O, position
*  CO sensor must be in CO position

é Sensors have very accurate locations, see below locations defined for each sensor:

When a sensor has been replaced, it is possible to check the proper functioning of this new sensor by going in the “Information”
menu of the analyser. It is normal that a sensor that has just been installed gives the following message: “Current Error”, it is
necessary to wait a few time to stabilise the polarisation of the sensor.
Here are the stabilization times for each sensor:

e 0248 hours

*  CO-H,: 48 hours

21.3. Replace the paper roll of the printer

Follow this procedure to replace the paper roll of the printer:

Raise the upper part of the printer.

Put the paper roll in the required location.

Pull up slightly on the paper: it must be caught between the upper part and the lower part of the printer.
Close the upper part.

Some paper must be out from the slot situated between the lower part and the upper part of the printer part.

YVVY

ABoth sides of the paper are different: the brightest side is the printed side and must be facing the user.

Upper part to Paper location Introduction of Paper correctly
raise the paper roll introduced
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21.4. Replace the battery

Follow this procedure to replace the battery:

The analyser must be turned off.

Remove the protective cover.

Turn the analyser.

Unscrew the battery cover with a cross-head screwdriver.
Remove the battery cover.

Disconnect the battery.

Connect the new battery.

&vvvvvv

Do not pull the cable, unplug softly the connector.

22. Calculations of the different parameters

22.1. CO and NO conversions

co[91=C0| ppm ] x1.24922
mg

7\'_ COZmax_ 21

~ €0, 21-0,

co[ M9 1=co™ )V
kWh m*"" PCIx0.277778

9 1_corme Vi
COLawn)=COL 51 oo arrrrg X000

v
co[-L1=co[-19 )5 __0.001

GJ kWh-" PCIx0.277778
mg/m? mg, 21=0y
CO[ OZret ]_CO[ m3] 21_Oz

CO[%]=CO[ ppm] x0.0001

mg

co[-L1=co[ ™ 1x0.001
m m

With:

O a reference value selected by the user, this value has to be entered in the device in %.

0O, oxygen value measured in %.

Ve the theoretical volume of flue gas in m® (given in the table of coefficient)

NCV the net calorific value in MJ (given in the table of coefficient)

COzmax the maximum level in % in carbon dioxide of flue gas dry products (given in the table of coefficient)

22.2. Calculation of flue gas velocity

V:k\/2AP
MVF

With:
«  k: coefficient of the differential pressure item
» AP: differential pressure (dynamic pressure).
*  Muw: mass density of the flue gas (already calculated for the calculation of the higher efficiency).
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1. Introduction

LIGAZ-2 software, supplied with the gas analysers of the KIGAZ range, allows to set the analyser, to create and give information a
customers, boilers and inspections database, to process and download measurement datasets.

2. Software installation

2.1. Recommended minimum configuration
For the proper functioning of the software, the following minimum configuration is recommended:
*  Operating system: Windows, XP, VISTA, 7
e Communication port: USB 2.0
« DVD player
*  RAM memory: 1 GO
*  Disk memory: 1 GO

2.2. Installation

» Put the DVD into the player of the computer.
It automatically starts. If not, go to “My computer”, double-click on DVD drive then on “SetupLIGAZ-2" icon.
»  Follow the indications of installation.

Setup L] Setup X Setup ()

: LIGAZ-2 Setup Wizard
Welcome to the LIGAZ-2 Setup LIGAZ-2 Setup Wizard -~ Fram::m izal
Wizard L1GAZ-2 Software

INSTRUMENTS

This wil instal LIGAZ-2: te
is il nst n your computer, WARNING :

If a device is currently connected to the
computer, unplug it

You will be able to connect it when the
complete installation of the application is

finished. >

Itis recommended that you dose all other applications before
continuing.

Setup steps :

Click Next to continue, or Cancel to exit Setup. net Framework.

I:l Diiver KIGAZ
I:l LIGAZ:2 Software

LIGAZ-2 LIGAZ-2 Click next button to start setup

) uGAzZ2 [ESERENL X ] o - Setup S
Welcome to the LIGAZ-2 Setup Wizard ‘, LIGAZ-2 Setup Wizard LIGAZ-2 Setup Wizard
. L1GAZ-2 Softnare Driver KIGAZ
=

The installer il guide pou through the steps required to install LIGAZ-2 on your computer.

Setup steps : Setup steps

net Framenork.
net Framewark

Diiver KIGAZ

Driver KIGAZ -
LIGAZ-2 Soltware H o D HEAZ:2Scliars
Wb RNING: This computer program is protected by coppight law and international treaties.
Unauthorized duplication or distribLtion of this pragram, or any portion of it, map result in severs civil
o1 ciminal penalics, and willbe prosesuled to the masim.m exter possible under the
LIGAZ-2 Click nest button to start setup LIGAZ-2 SKne bulan o slat selip
2 = -
a2 e 4 teaz2 ol Setup e
Select Installation Folder wé" & Installing LIGAZ-2 o Completing the LIGAZ-2 Setup
oo G Y. Wizard

INSTRUMENTS

Setup has finished instaling LIGAZ-2 on your computer,
The instaler wilinstall LIGAZ2 to the following folder. LIGAZ2 s being instlled. P a ¥e o
Toinstal in this folder, dlick "Net". To instalto a diferent folder, erter it below or click "Browss". Click Finish to exit Setup.

Please wait
Eolder | ]

C:\Pragram Files (8E]WKIMO Instruments\LIGAZ-2 Browse... >

Install LIGAZ2 for yoursef, or for anyene who uses this computer:

@ Everyone

© Justme

Corcel | [ <Back | [ Newt» <Back Next>
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3. Start with the software

After double-clicking on the o software launching icon on the desktop, the homepage of the software opens:

1 |0 LAz 2: 198
File_Databese KIGAZ _Options _Windows _? _(Connect device

2/ a8 480

3 LGAZ-2
{3 ~ v1981e

Connection Downlosding
Databsse Setting
.1>C7‘ o: Please select an option in the menu

mmmmmmmmmmm 0 Comectdevies

3.1. Meaning and functions of the menus bar (1)

» File
» Back to homepage: reduce all the opened windows
» Save database: save the database into the computer
* Import database: import a LIGAZ-2 or LOGAZ-2 (optional software) database saved into another computer
*  Quit: close the software
> Database
» Total: opens the total database window (Customers, boilers and performed inspections)
»  Customers: opens the customers database window
» Boilers: opens the boilers database window
» Database setting: opens the saving setting window of the database (location and recurrence)
> KIGAZ
* Downloading: allows to download data saved in the analyser and the instrument setting
«  Setting: allows to set different parameters (autozero, combustibles, references...)
» Customers / boilers deletion...: allows to delete customers and/or boilers saved in the analyser
»  Comparison of PC elements with KIGAZ...: allows to compare information on customers and boilers between the
LIGAZ-2 database and the analyser
» Options
e E-mail: allows to set parameters to send emails
» User: information about the user
* Languages: allows to select the software language (French or English)
> Windows: allows to go from one window to another
> 7
* User manuals: allows to get to software and analyser user manuals
* Hotline: allows to get to the address and fax and phone number of the company or send a report to the after sales
service
« About: indicates software version and database version
» Device connection: indicates the connection state of the device connection. “Connect device” or “Device connected”.
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3.2. Meaning and functions of tool bar buttons (2)

4% | Back to homepage: closes all the opened windows il. Opens the boilers database window
Opens the complete database window .
h I I
1 (Customers, Boilers, Inspections) g’ Opens the analyser download window
]. Opens the customer database window ° | Opens the analyser setting window

3.3. Meaning and functions of the homepage buttons (3)

Allows to connect the analyser to the software | Allows to connect the analyser and access the
= inspections unload window
'1% Allows to access the complete database: ¢ & | Allows to access the analyser setting
Customers, boilers and inspections

4. Download inspections

Inspections stored in the analyser can be downloaded on the computer:
» Connect the analyser to the computer thanks to the supplied USB cable and turn on the analyser.
» Launch LIGAZ-2 software.
» Connect the analyser to the LIGAZ-2 software clicking on the homepage button.
The software indicates that connexion is successful. g |

» Click on the download homepage button g\
Or
» Click on “KIGAZ” menu then on “Downloading”.

Or
»  Click on the download icon of the tool bar £~
The software recovers inspections contained in the analyser. This operation can take a few minutes.
At the end of the recovery, the following window is displayed:
(‘g\ls’m:b:sei‘.nm;jo;:js Windows 7  Analyzer connected

KIGAZ 110

» Tick the boxes corresponding to the inspections to download on the computer. To delete an inspection from the instrument,
tick the “Delete” box. To download an inspection to add to your database and delete it from the instrument, tick both boxes.
> Click on the Download selected inspections | button.
A message indicates that the transfer started, then the message “Transfer done” is displayed.: the dataset has been
downloaded successfully.
» Click on OK.
The “Complete database” window is displayed with the new inspections downloaded.
Customers and boilers linked to the downloaded inspections are added to the “Customers” and “Boilers” databases.
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5. Use the different databases

Databases are used to give information about features of boilers and customers. LIGAZ-2 software allows to recover customers and
boilers created in the analyser and allows to transfer customers and boilers created with LIGAZ-2 software in the analyser.

» Launch the software by double-clicking on the o icon in the desktop.
» These databases are saved in the hard disk of the computer. See page 48 for the “Database settings”.

5.1. Use the customer database
> Clickonthe Jy button of the tool bar or click on “Database” menu, then on “Customer”.

The following window is displayed:

© File Datsbase KIGAZ Options Windows ? Analyzer connected
LA RN IR NRS

Customers Details

- N

-

nnnnnn

aaaaaaa

The fields are not accessible.

The customer list created on the device are displayed on the left of the screen.
To add a customer, click on the Add customer | button.

The fields become accessible.

Fill in the different fields. The “Name” field is required.

Tosaveit, clickonthe [  save customer | button.

A confirmation message is displayed.

Click on OK.

The created customer appears in the list on the left of the screen:

Eae—

ustomers

YV VV V

ac
mmmmmmmmmmm

nnnnn

e
wwwwwwwwwwwww
nnnnnnn

» Repeat the procedure to add other customers.
» To transfer a customer to the analyser, select it on the customer list on the left of the screen and click on the following button:

Send 1o device |. If it is inaccessible, check the device connection.
A message confirms the successful transfer.
> Click on OK.
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To download customers from the analyser to the software database, it is necessary to download inspections present on the
device (see page 54). Only the customers linked to an inspection are added to the “Customers” software database. The
boilers linked to this customer are also added to the “Boilers” software database.

> To delete a customer, select it in the customer list and click onthe =

A confirmation message is displayed:
» Click on YES to confirm the deletion, or on NO to cancel.
» Click on the Clase
button to access the complete database.

5.2. Use the boilers database
Each customer can have several boilers.

L

Delete customer

| button.

| button to close the window and back to the homepage or on the

Back to database

» Clickonthe ™ | tool bar button, or on “Database” menu then choose “Boilers”.

The following window opens:

© File Database KGAZ Options Windows 7 Analyzer connected

-8 x

& =
A | (] w
Add. boiler + Customer - Browasis
e Mo
EEEEEE end
CCCCCCCCCCCCCCC
erial “ Power (kW)
- Evacuation mods
@ B type (No Leakproof) C type (Leakproof)
Browse... Automatic

Using burner. (=] Delete bumer

All the fields (type, model, power...) are inaccessible and the “Browse” button is inactive.

> To add a boiler, click on the addaboloy | button.

The fields become accessible and the Browse., | button is active.
> Fillin the different required fields (customer, model, power in kW and combustible) as indicated below.

> Click on the Browse.. | button in front of the “Customer” field to link the boiler to a customer.
The following window is displayed:
@) Database : Customers = | 1) [
[oews
Add customer * Name -
ABsb ABab
E:[C First name:
é\;’:ﬁ:wn}jde ) Addl
E-Mail
Comment 13
* Required fields
[5)  Deiete custom = Sava customer
Select customer Cancel
» Select the required customer in the list on the left then click on the Selsct customer | button.

The software back to the previous screen.
» Fillin the “Model” and “Power” required fields.
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» Click on the Browse. | button in front of “Combustible” and select the combustible type of the boiler.
The following window is displayed:

.
Database : Combustibles o b S|
) stble: s
Add combustibla Combustible : Energy
GAS -
SaharaFos Nal, gas Sahara/Fos Nat. gas
Groninguen Nat. gas A1 cosficient A2 coefficient
Russial... Nat. gas o 0
Propane
f|Lre B coefficient : K coefficient k :
Butane
1| Light oi o 047
Heavy fuel ail CO2max coefficient CO2Max VF coefficient
|| cannetcosl - -
Low volatile coal .85 8,25
Coke gas VA coefficient AC coefficient :
Biafuel 5%
Wood 20% 103 168
| ;‘;‘gat'“ﬂf}‘ﬁ” % PCI coefficient
38,9
[5]  Deleta combustibie | Il save combustibla |
Cancel Select combustible |

» Select the combustible used by the boiler and click on the Selectcombustble | button.
15 types of combustible are programmed. If the combustible type used by the boiler is not available in the list, click on the

Add combusible |button, fill in the fields, click on the ke save combusiivie | button then on the Select combustible |
button.
> To save the boiler, click on the kd Save boiler | button.
The software displays a confirmation message.
» Click on OK.
The created boiler appears on the list on the left of the screen:
IR RTINS

ODELE
CHX1 60 CHALDERA
Seritnumber * Power (kW)
o

* Evacuation mode

® Biype (No Leakproof) ) C type (Leakproof)
* Combustivle . Gaz Nat. Sahara/Fos e, Automatic
€ [] With aceumulaton balon []

13
L3

Lastinspection date 01011960 (v

Using burner. | (5] Delete bumer

) Osetsvoler =] Save boller

Closo |

Back to database Send to device

> Repeat the procedure to add other boilers.

» To transfer a boiler to the analyser, select it on the boilers list then click on the Send lo device | button. If it is not
accessible, check the device connection.

A message is displayed to confirm the transfer:

» Click on OK.

» To download boilers from the analyser to the software database, it is necessary to download inspections present on the
device (see page 54). Only the boilers linked to at least an inspection are added to the “Boilers” software database. The
customer linked to this boiler is also added to the “Customers” software database.

> To delete a boiler, select it on the boilers list then click on the [ Dalste boiler | button.

A confirmation message is displayed.

» Click on YES to confirm deletion or NO to cancel.

» Click on the Close | button to close the window and back to the homepage, or on the Back to detabass
button access the complete database.
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5.3. Complete database

This database allows to have a global view of all customers and their boilers with also the inspections.
» Click on the itool bar button or directly on the ib, button on the homepage.
Or
» Click on “Database” menu, then choose “Complete”.
The following window is displayed:

© File Database KIGAZ Options Windows ?  Analyzer connected

IR R IRNRA

Database Customers
pol Name Frstname Address  Address2 Address3 Phone &
=3 Database beta
i ABab
= Bjc Dupont  Jean 5 rue du Gaz 0102030405 g
& ‘.gtﬂa Warm Pascal Rue du Four 0123456789
e -
=& caki
‘Wb Boilers
-4, Dupont Jean Model Brand  Serialnumber Power Address Address2  Address3 Local Dateoflastswesping Last inspection date  First operating dale  Combustible Burner brand
B CHAUDIERA CHX160 - e pera Ry
{ 7} MODELE a 01/01/1960 Gaz Nat. Sahara/Fos
&, Warm Pascal a 22 2011172015 15:47:00 Gaz Nat. Groningue
b 23 20112015 15:57:00 Gaz Nat. SaharaiFos
MODELE 150 03112015 16:05:24 03172015 16:05:24 03112015 16:05:24 Gaz Nat. SaharaiFos
CHAUDERA CHX180 12345 160 4ruedela Biche Périgueux 0B/0B/2015 17-10.03  11/09/2015 17:10:03 0S/0S/2015 17:10:03 Bois 20%
o m ] v
Inspection N* Date / Hour Intervention type Planification tranfered Done Delete

T y— - N

1510000010007 20M1/2015 15:57:00 Sealing network Delete

Date / Hour 20/11/2015 16:08:00
15100000100006 20/11/2015 15:48:00 Combustion analysis Delete N

Preview
15100000100005 2041172015 15:47:00 Opacity measurement Delete

Start pressure :
15100000100004 20411/2015 15:47:00 Differential pressure Delete Measuremert 0 mbar

1510000010003 20M1/2015 15:47:00 Flue gas temperature Delete End pressure :

15100000100002 20M1/2015 15:47:00 Ambient temperature Delete Measurement 0 mbar
Network airthightness :

1510000010001 20/11/2015 15:46:00 Ambient temperature Delete

ORREERREEAEF
IS NI CS R SRS NS S

Measurement O mbar : Conforme
1501423100001 26M0/2015 17:05:00 Ambient temperature Delete
29M0/2015 03:00:00 Aftestation SOLID Delete

Measures

> To delete an inspection from the complete database, click on the Deketz | button of the inspections list.
A message is displayed to confirm deletion.
» Click on “OK” to confirm or “Cancel” to cancel the inspection deletion.

5.3.1. Database settings

» Click on “Database” menu then on “Database settings...”.
The database configuration window opens. Dot v =
> Click on the Browse. button and define the save folder path. S Eo
» Select the recurrence, that is the automatic registration of the database: ——
»  Select the database registration frequency: from 1 to 30 hours or 1 to —
30 dayS O | ._‘ Hours
Or | @ VWhen closing software . |
» Tick “When closing software” to save automatically the database when : .
the software is closed. | e —= |

Browse... I

5.3.2. Save while using

To guarantee information saving, you shall regularly proceed this way:
»  Click on “File” menu.
» Click on “Save database”.

5.3.3. Import a database

When opening LIGAZ-2 software, to recover a database:
» Click on “File” menu.
» Click on “Import database”.
» Go to the saving folder of the database, select the database to open then click on OK.
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5.4. Edit an analysis report

From the complete database screen, it is possible to edit a measurements report.
» In the menu on the left of the screen, click on the required boiler for the report edition.
» Click on the Measures | button.

The analysis report is displayed:

0 2112w por S =

@ File Database KIGAZ Options Windows 7 Analyzer connected -8 x
"y

LI R X TINRI

gIPage:l,ll o pdt

Analysis Report

N = of intervention 15100000100008

SPONSOR Address

caki

1

Faciiity Address (IF DIFFERENT)
Bailer location

BOILER IDENTIFICATION

Brand Model b Energy Gaz Nat. Sahara/Fos

Exhaust mode (AIR-TIGHT / NON AIR TIGHT) Mo Leakproof M
Serial number {IF AVAILABLE) Commissicning date Power rating 23 kW

Last maintenance date (IF AVAILABLE) 20/11/2015 Last sweeping date (IF APPLICABLE AND AVAILABLE)

FORCED DRAUGHT BURNUER IDENTIFICATION (IF APPLICABLE)

Date Brand Model

MEASURMENT DEVICE USED

Brand KIMO Reference KIGAZ 110

MEASUREMENTS DONE

Flue gas 0, CO Max [ Ambient CO

Flue gas CO Ambient CO;

Flue gas CO, Internal temperature

Ambient temperature Outqoing temperature 2

> Use theﬂl button to zoom in or zoom out on the report.
> Clickonthe L& button to print the report or on the ﬂ button to export it in PDF format.
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6. Set the analyser

LIGAZ-2 software allows to set the analyser. It is possible to:
* setthe combustibles
» set the references (O reference, altitude, atmospheric pressure)
» set the operators
» setdate and time
» get details about sensors (State and serial number)
» set the header of printing
*  see the battery level
» getinformation about the analyser, update it and send report to after-sales service

Connect the analyser to the computer with the supplied USB cable.

Connect the analyser on main power thanks to the supplied adapter to avoid extinguishing of the analyser (low battery).
Click on “KIGAZ” in the menu bar.

Go down to “Setting” then click on the parameter to modify.

or . Setting

Click on the ﬂ tool bar button or directly onthe ~ € g | button from the homepage.

“KIGAZ settings” window opens. o

YV VYVVYVY

Changing parameters of the analyser has consequences on performed measurements and on the analysis
calculation. Only a qualified technician is empowered to change the parameters of the device.

==

KIGAZ 110 1C 15.10.00001

6.1. Change the combustibles

This window allows to change the list of combustibles programmed in the analyser. It also allows to modify features of each
combustibles.
“KIGAZ settings” window is open on “Combustibles” or click on the & Combustivles | button.
» Click on the “Energy” field and select the combustible type: solid, liquid or gas.
» Double-click on one of the combustible features to modify.
> Enter the new value for the feature.
> Clickonthe comseibes. | button to send modifications to the analyser.

6.2. Change the references

This window allows to modify the O, reference (percentage of oxygen in the air which the analyser is used), the altitude (altitude in
which the analyser is used) and the atmospheric pressure (pressure in which the analyser is used).
“KIGAZ settings” window is open on “References” or click on the 8 References | button.
» Click on the field to modify.
» Write the new value.
» Click onthe mansterrererences.| button to send modifications to the analyser.

6.3. Manage the operators

This window allows to add, delete or modify an operator.
“KIGAZ settings” window is open on “Operators” or click on the T Operators | button.
» Inthe “Name” column, click on the field to write an operator name.
» Click on the Transteroperators...| button to send modifications to the analyser.
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6.4. Modify the date and time

This window allows to de sync the analyser time and the computer time.
“KIGAZ settings” window is open on “Date / Hour” or click on the & patesHour | button.
» Click onthe sewsweaime.. |button to adjust analyser time to computer time.

6.5. Sensors state

This window allows to access the sensors features of the connected analyser.
“KIGAZ settings” window is open on “Sensors” or click on the & sensors | button.
» The displayed features are:
»  Type of sensor (CO, NO,...)
»  State of sensor (connected, not connected...)
»  Serial number of the sensor

6.6. Set printings

This window allow to enter the 4 header lines of the ticket printed by the analyser.
“KIGAZ settings” window is open on “Printing” or click on the & Printing | button.
» Enter the required text in “Header line 1, 2, 3 and 4” lines.
» Clickonthe _ ssmss. | hytton to send modifications to the analyser.

6.7. Battery level

This window allows to see the battery level of the analysis. The analyser must be turned on and on battery.
“KIGAZ settings” window is open on “Battery level” or click on the { Baterylevel | button.
The software displays the battery level.

6.8. Access to information about the instrument and update the instrument

6.8.1. Access to information about the instrument

“KIGAZ settings” window is open on “Information” or click on the i Information | button.
The following information is displayed:
Product code: ex: KIGAZ 310
Serial number: ex: 00.01.2057
Firmware version: ex: 0.92
e Build: ex; 1247
It is possible to give an inventory number to the device (number selected and given by the user):
» Click on “Inventory number” field and enter the desired number.

6.8.2. Update the device

It is possible to update the firmware of the analyser, it means the internal software that allows to the analyser to work properly. It is also
possible to install a 3 language.
» Click on KIGAZ menu then go to Settings and click on Information, or click on the ﬂ tool

bar button then on the & information |butt0n_ [t
The “KIGAZ settings” window is displayed. P —

» Clickonthe Dpevicetotine | hutton.

The following window opens:

> Clickonthe Germenst | button. =
firmware _.

The connection parameters window opens: 8
Two choices are then possible:

uuuuuuuuuuuuuuuuu

If you are connected to Intemnet with a proxy. you
have to identify (or Cancel)

* The Internet connection is not protected by a proxy
> Clickon o | button on the connection parameters window. - .,

A progress bar is displayed then the available firmware number is displayed.

> Clickonthe e the deviee. | DULEON.

The update lasts for a few minutes.

» Turn off then turn the device.
A black screen with a progress bar are displayed (see opposite) then It turns off itself.

» Turn on the device then go to “Information” menu of the analyser to check if the update has been taken into
account.
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* The Internet connection is protected by a proxy

Address and serial number of the proxy, user name and corresponding password must be entered.

To get them into Windows 7:

Click on “Start” (1) then on “Control panel” (2).

In “Control panel” window, click on the up right on “Large icons” in “View by” (3).

Click on “Internet Options” (4):the “Internet Properties” window opens.

Click on “Connections” tab (5) then on “LAN settings” button (6): the “Local Area Network (LAN) Settings” window
opens with the information about the proxy server (7).

VVYVYY

‘earthz |
I
@ CTS-RF BOUROCHER Romain I Adjustyour computer's settings
= [ Documents
i :i WMicrosoft Office Word 2003 7 w sileverdonicicess .
"W Action Center {74 Administrative Tools B e emontue AutoPlay 8 Backup and Restore
ﬁ Dt X (32-bit) @ < &
OpenOffice.org 3.0 CinePlayer DVD Cecod =
SISO S | Color Management (B courrier (32-bit) B Credential Manager 7 Date and Time
Music x Options (32-bit) ﬂ q ) @ g
Q} LOGAZ @ oefauitprograms @ Desktop Gadgets é} Device Manager i Devices and Printers B oispiey
= Computer 2 .
OpenOffice.org Draw @ Ease of Access Center Flash Player (32-bit) ; Folder Options A Fents 4 Gettirg Started
Control Panel .
J LIGAZ q% HomeGroup g2 Indexing Options 4 (&) Java 2 biy <> Keyboard
: Devices and Printers e e irdoran i o
Py Location and Other ~m Network and Sharing s—" Performance Information
E e et P wouse o Notifiation Areatcons [l [y T
Default Prog ; i
" skt i B rersonaization & Phone and Modem F power opions [ Programsand reatres M Recovery
xl Microsoft Office Excel 2003 -
Kk siud Snppnt. @ Region and Language LS zz?::;?upnp:"d Desktop @ Software Updates (32-bi9) (@) Sound @ speech Recognition
@ KILOG RF
® synccenter &4 sysem [l Taskoar anc start Menu Troubleshcoting 8 ser accouns
»  AllPrograms ) ) N
& UWp'gi“d":A"“'me [ wirdows cardspace B89 Windows Defender o windows Firewal ] Windows Update

Shut down | ¥ |

e )

Automatic configuration

Automatic configuration may override manual settings. To ensure the

ction, dick Setup use of manual settings, disable automatic configuration.

.:g To set up an Internet conne:
Setup,

Disl-up and Virtual Private Network settngs —————————————— Automatically detect settings
Add. D Use automatic configuration script
I/ s
Remove.

Proxy server
Choose Settings if you need to configure a proxy Settings

oSS S ctiorn Use a proxy server for your LAM {These settings will not apply to
dial-up or YPN connections).

rault connection

Address:  10.25,221.11 Port: 8080 Advanced
Mo Set default
[¥] Bypass proxy server for local addresses
Local Area Network (LAN) settings
Choose Settings above for dial-up settings.

\~1J

» Copy the address and the port in the “Address” line of the connection window as follows: 00.00.000.00:0000

Address \P—Jr_t)

» Enter the user name and the corresponding password: data entered at the starting of the computer when the user logins.

> Click on the Ok button.

> Click on the l"""*"“"“""""""’---| button. Ereeri

The update lasts for a few minutes.
Turn off then turn on the device.
A black screen with a progress bar are displayed (see opposite) then the device turns off itself.
» Turn on the device then go to “Information” menu of the analyser to check if the update has been
taken into account.

6.8.3. Install a 3" language
» Select the language to send in the drop-down list box.

> Click on the Sﬂ“d3'dh"9m=| button.
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6.8.4. Send a report of the device to the After-Sales Service

> Click onthe  SendreportioHotine.. | button.
Kimo after-sales service will receive a report about the general state of the device only readable by the after-sales service.

6.8.5. Back to factory parameters

It is possible to set the device with the factory parameters.
The “Settings” window is open on “Information”.
> Clickonthe  sackmotacioryseings | button.
The device is now set with the factory parameters.(see the factory parameters page 21).

7. Options
7.1. E-mail

This option allows to set the email sending parameters in order to send report to the after- E-Mail. B
sales service. E-mail address of oLtgoing mail
» Click on the “Options” menu then on the “Email” sub-menu. Cutgaing mal server (SMTP)
The following window is displayed: —
> Fill'in the different fields: HTML :
* Email address of the outgoing mail: e-mail address of the sender e
(p.durand@orange.fr)
»  Outgoing mail server: server address used to send e-mail (ex: smtp.orange.fr). —Cowe | -

*  Mail format: plain text or html
* Advanced options: by clicking on the  asances opiions... | button, the email setting window opens and allows to set the
SMTP outgoing server. This information is delivered in the subscription documents of the Internet access provider

> Click on the Ok button.

7.2. User information s o
This option allows to give information about the software user. o

» Click on the “Options” menu then on the “User” sub-menu. S

The following window is displayed: o

» Fillin the different fields. Phone -

> Click on the o button. =

7.3. Change the language e B
This option allows to change the interface language.

» Click on “Options” menu. e o

» Click on “Languages” sub-menu.
» Select the required language.
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8. Customers / Boilers deletion of the analyser

It is possible to delete customers and/or boilers saved in the analyser via the LIGAZ-2 software.

» Connect the analyser to the computer then detect it with the LIGAZ-2 software.

» Click on “Menu” then “Customers/boilers deletion...”.
The following windows opens:

Customers / Boilers deletion,

KIGAZ 110 1C 15.10.00007

Customers :

Boilers :

[[] Anthonin DUCRASSE
[ Baptiste DEMMERLE
[] Benjamin CHAUPRADE
Benoit VIDAL

Bryan CRANSTON
Charles BILLOT
Clément NICOLAS
Erilkc LE ROUGE
Fanfan LA TULIPE
Ferdinand BARDAMU
Freddy MERCURY
Gaston LAGAFFE
Gengis KHAN
Grégory CARILLO
Grigori RASPOUTINE
Guillaume MACIEL

EOEEEEEEEEE

Rz

[[] ThemaClassic DUVAL
[ ThemaCondens DUVAL
[[] ThemaPlus DUVAL

Close |

To delete a customer from the analyser:

> Tick the box of the customer to delete then click on the

A message of confirmation is displayed.
» Click on “Yes” to confirm the deletion.

To delete a boiler on the analyser:

)

» Click on the line of the customer to whom the boiler to delete is associated.
> Tick the box of the boiler to delete then click on the
A message of confirmation is displayed.
Click on “Yes” to confirm the deletion.

=

button between “Customer” and “Boiler” columns.

button on the left of the “Boilers” column.

A Inspections linked to the deleted customer or boiler are also deleted.
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9. Compare the instrument and software information

As we have seen, the LIGAZ-2 software allows to send information to the analyser or to delete information from the analyser:
»  Sending customers or boilers to the analyser
*  Download customers/boilers/inspections from the KIGAZ to the software
*  Delete customers and boilers from the analyser

The “Comparison of PC elements with KIGAZ” function in the KIGAZ menu allows to update customers and boilers information in
the analyser and in the LIGAZ-2 software databases. There are different possibilities.

Inspection deletion (see page 44)

Send a customer or a boiler to the device (see page 45)

Customers/hoilers deletion (see page 45)

Customers/boilers/inspections downloading (see page 44)

Comparison of PC elements with KIGAZ

A

9.1. Add elements automatically in the databases

The LIGAZ-2 software will add automatically customers and boilers in the following cases:
» Ifthe same customer is present in the analyser and the software “Customers” database but different boilers are associated
to this customer, the software will add automatically the missing boilers in the “Customers” and “Boilers” databases.
» Ifacustomer is present in the analyser with at least one associated boiler, the software will add it automatically in the
“Customers” and “Boilers” databases. But if a customer is present in the analyser without associated boiler, the software
will not add this customer in the “Customers” database.

Procedure:
> Click on “KIGAZ” menu.
» Click on “Comparison of PC elements with KIGAZ".

9.2. Modification of customer and boilers features

The LIGAZ-2 software will compare the information: if a customer or a boiler is present in the analyser and the database but with
different features, the software will ask which features have to be taken into account.

Procedure:
» Click on “KIGAZ”.
» Click on “Comparison of PC elements with KIGAZ".
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The following window opens:

Synchronization PC <-» KIGAZ,

Required synchronization:

() Synchronize data of the PC and KIGAZ
() Do nothing (keep the data as they are on the PC and KIGAZ)
Which data you want to keep?

PC data KIGAZ data

s

BLANC ALAIN
Adresse : 12 RUE DU SOLEIL ‘
LIEU DIT OUEST 24700 SAINT REMY SUR (/=]

BLANC ALAIN

Tel : 0553308500

| Tel - 0553808500
E-Mail : T

E-Mail

-

Apply this choice for other tems to synchronize.

Adresse - RUE DU SOLEIL | ‘
LIEU DIT QUEST 24700 SAINT REMY SUR

s

[

To keep the data as they are on the PC and KIGAZ:
» Tick the “Do nothing (keep the data as they are on the PC and KIGAZ)”
» Click on the “OK” button.

To update the information:
» Tick the “Synchronise data of the PC and KIGAZ” box.
» Tick the boxes of data to keep.
» Click on “OK” button.

box.

6 To do the same actions on the following data, tick the “Apply this choice for other items to synchronise” box.
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Once returned to KIMO, required waste collection will be assured in the respect of the environment in accordance to guidelines relating to WEEE.
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